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The Mac Mini as an  
Entertainment Server

I have long been fascinated with 
the idea of an all-inclusive digital 
entertainment server. Ideally this would 
be a simple, low power device that 
would connect to both my receiver and 
television. It would host my 75 GB music 
library, digital movies, some games, even 
my digital photos and artwork. It would 
banish the clutter of DVDs and CDs to 
deep storage. It would connect to the 
Internet for streaming audio, Podcasts, 
and weather and news reports. And it 
would do this in the living room, where 
friends and family tend to congregate.

I already had a 40 GB iPod connected 
to my stereo via the iPod dock. The sound 
was great, the interface simple, and it 
required little electricity to run. However, 
the 40 GB iPod could only hold half of 
my music library, and it was occasionally 
awkward to browse so much music on the 
small device. When the Airport Express 
came out, I tried streaming music from 
iTunes on my desktop computer to the 
stereo, which was neat, but there was no 
great way to browse my music selection 
from the couch — I had to go to the 
computer room to do this.

The Mac mini seemed to be the device I 
was waiting for. So, in the name of science, 
I purchased a 1.42 GHz Mac mini with 1 
GB of RAM, 80 GB hard drive, Combo 
drive, and Bluetooth and Airport Extreme 
cards. I also purchased the Apple DVI to 

Video adapter, to connect the Mac mini to 
the S-video port on my television, and the 
Monster iCable to connect the audio port 
on the Mac Mini to my stereo receiver. I 
would use a Macally Bluetooth mouse to 
control the Mac mini.

Fifteen minutes after I brought 
everything home, the Mac mini was 
connected to the television, playing a 
CD from iTunes, and running Software 
Update via Airport Extreme. Now, with 
only an 80 GB internal hard drive, and 
75 GB of music, plus dozens of gigabytes 
of photos and movies, it was clear that 
I would need an external hard drive. I 
loaded up an older 160 drive with all of my 
music and videos, and loaded my entire 
iPhoto library onto the 80 GB drive in 
the Mac mini. After downloading a few 
essential applications, and upgrading to 
QuickTime Pro, the Mac mini was ready 
to serve as my home entertainment hub.

After a couple of months, I can say it 
does what I wanted it to do. It keeps my 
digital entertainment files organized in 
one central location. Every song or movie 
file is immediately at hand, especially with 
Mac OS X 10.4’s Spotlight feature. The 
Mac mini does a great job of playing CDs, 
DVDs, and digital files such as MP3s 
and movies. Apple’s familiar bundled 
programs, such as iTunes, DVD Player, 
QuickTime, Safari, and the colorful Tiger 
Widgets handle these files with ease. The 
video quality coming out of the Mac Mini 
is great — iPhoto pictures, QuickTime 
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slideshows, DVDs, even the iTunes 
visualizer look excellent on TV. 
Simple games also look great, but 
I do not play these often. Overall 
system performance is excellent.

There are a few things to consider 
for the future. First, I currently have 
a CRT-style television, and because 
of the scan-lines, text is difficult 
to read. I have adjusted the system 
settings to improve this, but it won’t 
truly be resolved until I upgrade to 
an LCD television in the fall. This 
is only a problem with text; images 
look great.

The Mac mini has no native 
video-in port or TV tuner, making 
video recording impossible without 
using a third party device, such as 
a Miglia Evolution or EyeTV. The 
audio quality is very good, but not 
absolutely spectacular. 

I may buy an audio output 
device, such as the Griffin Firewave, 
to improve the audio output. I 
will probably purchase a Micronet 
Minimate or LaCie mini, to replace 
the hard drive I currently have 
connected to the mini. Finally, I 
now have more cables and more 
electrical demand than before the 
Mac mini. In its current incarnation, 
the system is a little more 
complicated than planned, though 
works as intended.

Apple may someday come 
out with their long-rumored 
entertainment server. In the 
meantime, I am happy with the 
Mac mini. It has been fun for the 
family, and my friends think it’s 
pretty cool, too.

Order Ed’s Mac mini set up: 
Mac mini, iCable and DVI to 
Video connector for $479. To 
order: http://www.smalldog.com/
wag16025/attt 
~ Edward Shepard

Small Dog Electronics

HDTV on Your Mac
Even though the Mac is a little 

late to the HDTV party, you can 
roll your own setup for not too 
much time or money. Erica Sadun 
shows you how.
http://www.macdevcenter.com/
pub/a/mac/2005/03/29/hdtv.html

The MUG Center
via TMUG Insider, Pleasanton, CA

Silence the Volume Keys
Q: When I adjust the volume 

of my Mac using the volume keys 
on my keyboard, my Mac makes a 
beep every time I press a key. How 
do I shut it up?

A: Hold down the shift key 
while pressing the volume keys on 
your keyboard to silence the beeps. 
Alternatively, you can squelch 
volume-key feedback for good: 
Open System Preferences, click the 

“Sound Effects” tab, and uncheck 
the box labeled “Play Feedback 
When Volume Keys Are Pressed.”

MacAddict Magazine

Redirecting Files
I have a text file written in 

a “classic” text editor on an older 
Macintosh. I copy the file to the 
iBook with OS X 10.3.3, and 
want to work on it there using, 
say, BBEditLite. I click the file 
icon, press Command/I for “Get 
Info,” click “Open with,” then select 
BBEditLite. Double clicking the 
file then opens it with that program. 
A further extension of this is the 
following. I continually receive 
Microsoft Word documents, and am 
required to read them on my iBook, 
which does not have a copy of 
Word. Recently, if I double-click the 
Word file, it has opened in Nisus 
Writer Express, of which I have 
only a 30-day demo. Apparently 
this is the most recent program I 

have installed that can open Word 
documents. I click on the file icon, 
press Command/I for “Get Info,” 
click “Open with” to access a list 
of other programs that might read 
the file; I choose icWord. The file 
will then open in icWord. However, 
I can also then click the “Change 
All” button in “Get Info”; the effect 
is that double-clicking subsequent 
Word files will automatically open 
in icWord. ~ Bruce Craven
AUSOM News, Melbourne, Australia

Customizing the Finder Toolbar
As I was playing around with 

“Get Info,” I decided to check out 
the tools to customize my Finder 
windows. There are basically two 
locations that allow you to set up 
the Finder to best suit how you 
work.
Finder Preferences

If you are in the Finder you 
can go under the Finder menu 
item and choose Preferences. The 
Finder Preference has four tabs. The 
General tab allows you to specify 
which items are shown on the 
Desktop. You can select (or deselect) 
hard disks, CDs, DVDS, iPods, 
and connected servers. You can also 
select which window you would 
like to open when you open a new 
Finder window. The choices are the 
Home directory, a specific drive, or 
any folder on your Mac.

Other General preferences 
include whether you want to open 
a new window every time you open 
a folder and whether you want to 
open all new windows in column 
view ( I have that one checked 
because I find the column view the 
most useful). You can also set the 
delay rate for spring-loaded folders 
and windows.

The Labels tab allows you to 
set colors and names for labels. 

http://www.smalldog.com/wag16025/attt
http://www.macdevcenter.com/pub/a/mac/2005/03/29/hdtv.html
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The Sidebar tab lets you set the 
items to be shown in the Sidebar. 
In the column view, the sidebar 
contains the icons for drives, servers, 
Desktop, Home directory, and 
Applications folder. Documents, 
Music, Movies, and Pictures are in 
the sidebar by default. You can also 
manage your sidebar by dragging 
items into or out of it, much like 
the dock.

The Advanced Tab allows you 
to select whether you want a 
warning before emptying the trash 
or whether you want to show all 
file extensions. I opt for the Trash 
warning and skip the file extensions 
(that’s a Windoze thing!).

What about the Toolbar? Where 
is the Finder toolbar and how do 
you modify it? The toolbar is the set 
of icons that appears on the top of 
every Finder window. The default 
set includes:
•	 Back and advance arrows 
•	 View choices 
•	 An action “gear” that allows you 

to Open, Get Info, Copy, Show 
View Options or Label any file 
with drop-down menu choice 

•	 A search window
You can add others or eliminate 

some of the default selections by 
going to the View menu item and 
choosing “Customize Toolbar.” 
There you can drag other choices to 
the toolbar and arrange them the 
way you like. Don’t want something 
in the toolbar? Drag it out and 
it disappears in a puff of virtual 
smoke.

You can add the following tools:
•	 Path (this tool allows you to see 

the path to get to a particular 
file)

•	 Eject Button 
•	 Burn Button (to burn CDs or 

DVDs) 
•	 Customize (this would allow 

instant access to the customize 
toolbar menu -- I can’t quite see 
the need for this one) 

•	 Space and Flexible Space (for 
organization and looks on the 
toolbar)

•	 New Folder 
•	 Delete (careful with this one!) 
•	 Connect (to servers) 
•	 Get Info 
•	 iDisk

My current set has: Back and 
Advance Arrows, View Choices, 
Action Path, Eject, Get Info, New 
Folder, and Burn.

You can choose to display icons, 
text, or both. You can also shrink 
it all down by choosing “Use Small 
Size. ~ Don Mayer

Small Dog Electronics  

Upgrade or Wade Up?
Q: I have a Power Mac G4 (PCI 

Graphics) with 320MB of RAM 
and a 10GB hard drive running 
Mac OS 8.6. I use Microsoft 
Office 98, Outlook Express, and 
a few games, and I have a dial-up 
connection to the Internet. I’d like 
to add a second hard drive, install 
OS X, and use Virtual PC 7.0 with 
a current version of Windows. Will 
using OS X cause a noticeable drop 
in performance? If so, is a processor 
upgrade worth it, or should I look 
for a new Mac? ~ Keith Thomas

A: Yes, you will notice a 
difference in performance when you 
move from the old Mac operating 
system to OS X. When I use my 
Mac that’s still capable of booting 
into OS 9, I’m astounded by how 
much more responsive it is in the 
old OS. Of course, I’m quickly 
brought back to earth when I recall 
that I can’t perform simultaneous 
tasks in the old OS.

Setting performance aside for 
the moment, let’s look at the cost of 

what you’re proposing. At press time, 
a 1GHz processor upgrade from 
Sonnet Technologies costs $400, a 
120GB ATA hard drive costs about 
$85, OS X 10.4 (Tiger) will run you 
$129, and Microsoft’s Virtual PC 7 
will set you back another $129. My 
Calculator widget tells me you’ll be 
putting $743 into this old Mac.

Compare that with the $499 
price tag of a new 1.25GHz Mac 
mini, which comes with OS X 
installed. You already have a 
keyboard, a monitor, and a mouse 
that will work with the mini. I’d 
configure the mini with 512MB 
of RAM and upgrade to an 80GB 
hard drive — you’ll want the extra 
RAM because 256MB just isn’t 
enough to get the best performance 
from OS X, and a 40GB hard drive 
will be cramped if you play games 
and run Virtual PC. Apple charges 
$75 and $50 for these upgrades, 
respectively. Virtual PC will still 
cost you $129. So a mini, a hard 
drive, and Virtual PC add up to 
$753.

I’d feel a bit better if you also put 
a copy of Microsoft Office 2004 on 
this machine, but you can get along 
by running your version of Office 
in the Classic environment (you 
should switch your email client to 
Apple’s Mail, however, as no version 
of Outlook Express exists for OS X).

If it appeared that you required 
a more open Mac — one in 
which you could add PCI cards 
or additional internal hard drives 

— the decision wouldn’t be so easy 
to make. But your needs appear 
to be modest enough that I’m 
comfortable saying, “Out with the 
old and in with the new!”

Chris Breen’s Mac 911  
via The Finder, Mid-Columbia MUG, 

Kennewick, WA
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A Remark on Text Editors
While many text files open 

automatically under OS X in 
Apple’s Text Edit, this useful 
program is not always the text editor 
most suitable for one’s purpose. 
If one’s concern is computer 
programming, or TeX or LaTeX 
source code for typesetting, then 
one needs a text editor that only 
does things like word wrapping, or 
formatting like RTF, or insertion 
of tabs, when one specifically asks 
for them. Also, one may want line 
numbers easily accessible. For OS 
X, I have found BBEditLite and 
Tex-Edit Plus (current version 4.8.3) 
to be valuable for the purposes I 
mentioned. (And I am currently 
writing this Blurb in BBEditLite for 
Mac OS X.)

Also, while formatting features 
(when used) are usually not 
transferred by “drag and drop” 
between different editor programs, 
there is some extent of inter-
changeability between the programs 
mentioned here. Of course, I am 
not rubbishing all other text editor 
programs, but just citing some 
programs that I find useful for my 
purposes. The motto here is “horses 
for courses!” ~ Bruce Craven
AUSOM News, Melbourne, Australia

Portable Updates
Q: I have a PowerBook and an 

iMac. Unfortunately I do not have 
high-speed Internet access at home, 
so some of the large downloads 
can take a few hours. I can take 
the PowerBook to a remote site and 
retrieve the updates through a high-
speed wireless connection, which 
helps considerably. Here’s the big 
question: Once I get the update 
on the PowerBook, is it possible to 
transfer it to the iMac?  
~ Ken St. Marie

A: Software Update cleans up 
after itself. Once you’ve downloaded 
and applied an update, the update 
package is automatically deleted 
to keep your hard disk free of 
unnecessary files. You can choose to 
keep the update packages, though, 
which you can then transfer to your 
iMac. Choose “System Preferences” 
from the Apple Menu and click 

“Software Update.” Click “Check 
Now” and wait for a list of available 
updates to appear. Command/
click each update you want to 
download and install, and then 
choose Update > Install and “Keep 
Package.” Software Update will now 
go about its business, downloading 
and installing the update. Once 
it’s finished, you’ll find the installer 
packages at Macintosh HD > 
Library > Packages. You can then 
transfer these packages to the iMac 
and install them at your leisure.

Of course, there are bound to 
be updates you need that do not 
show up in Software Update. You 
may have already applied a number 
of updates to your PowerBook, or 
there could be an update specific 
to your iMac. In these cases, you’ll 
want to go to www.apple.com/
support/downloads and grab any 
updates you might have missed. 
Updates downloaded through apple.
com will appear in your downloads 
folder. Once you get home, you can 
transfer the packages to your iMac.

macHOME Journal

Time to Preach About Backups 
Again

My G5 iMac developed 
overheating problems recently and 
Apple decided that it needed a new 
motherboard. Took it in for repairs 
alter doing a complete backup 
and decided to have a bigger hard 
drive installed while they had it 

apart. When they tried to clone 
the drive back to the new drive, 
it kept hanging and they finally 
decided that the original drive was 
also defective. Fortunately, I had 
that mirror backup on an external 
drive and was able to restore from 
it. The additional benefit was that 
I was able to run my iBook from 
that drive while the iMac was in 
the shop. I had access to all of the 
apps, fonts and other files that I use 
normally on the iMac but are not 
installed on the iBook. I’ve ordered 
a case for the replacement 80 gig 
drive and will use it for backing up 
my iBook.

Backup Benefit #2: I launched 
iCal and something went wonkie, 
gave me an obscure error message, 
and my calendars disappeared. Did 
the usual “plist” trashing, but it 
didn’t help. 

It seems that Apple, in its infinite 
wisdom, made some major changes 
in Tiger. No longer are your 
calendars stored in recognizable 
form. They now have numbers and 
multiple files. Bad Apple! They used 
to be in the home Library folder, 
in the (surprise!) Calendars folder 
with the same names you gave 
them to start with. Now, you have 
to burrow through home > Library 
> Application Support > iCal only 
to be met by a bunch of folders 
with impossibly long alphanumeric 
names that are meaningless. 

The files were all there, but iCal 
either couldn’t find them or couldn’t 
read them. 

Fortunately, I still had the last 
backup I did of Panther before 
installing Tiger and was able to 
import them and recreate the 
missing events. Not fun, but better 
than starting from scratch. 

Under the File menu in iCal 
you will find a “Backup Database” 
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command. Do yourself a favor 
and use it when you make major 
changes. If you ever experience a 
loss like this, it will be easy to just 
restore from that backup.

This was my month for 
troubleshooting problems. 
Right alter iCal went bonkers, 
MasterJuggler, my font manager, 
did the same thing. Launch, Wink, 
error message, and all of my font 
sets were gone. You don’t want to 
know how many fonts and sets I 
have on my system. Tried trashing 
the “plist,” dumping the MJ 
database file and replacing it with 
one from a backup and nothing 
was working. 

I finally, and I still don’t know 
what prompted me to do it, booted 
from one of my backup drives, 
replaced the database with a copy 
of the one in the active drive that 
I knew was working, and finally 
rebooted from my internal drive. 
That time it took. 

For some reason, even with 
MasterJuggler not running and the 
background helper app disabled, 
every time I replaced the database 
with a clean file, it would revert to 
the corrupt state. Like I said, it has 
been a strange month.

Backup those files! Two backups 
are even better. I actually have 
three for my iMac. One is an older 
drive that has the last update of 
Panther. Drive number two has 
a full mirror copy of my current 
drive setup. I updated it generally 
on a weekly basis and definitely 
before making any system updates. 

If I run into an update that 
breaks things (yes, it does happen) 
I have a working clone to revert 
to. The third drive runs all of the 
time. I have my software set to 
automatically backup my user 
and Documents folders every 

morning. If I am working on a 
critical InDesign project, I’ll trigger 
a backup of my Documents folder 
more often.

MacNews, Detroit, MI

Mac OS X

Switching Applications
Have a number of applications 

open and need to switch to one of 
them? Hold down the Command 
key and press the Tab key.
Apple Pickers MUG, Indianapolis, IN

Labels
There are lots of great things 

about Panther (10.3) and later, but 
file labeling is not one of them! 
Someone decided that instead of 
coloring the icons themselves (as 
in Mac OS 9), they’d color the file 
names.

This makes some kind of sense 
when you consider that some of 
OS X’s ornate icons may not take 
well to being colored, but it wreaks 
havoc on filenames presented in List 
or Column view, or in Open/Save 
dialogs, since the colored bars are 
both obtrusive and excessively bright.

To the rescue comes Unsanity, 
publisher of a number of OS X 

“haxies” including the esteemed 
Windowshade and now Labels 
X, which restores the OS 9-style 
labeling system icons in which the 
icons themselves are tinted with 
colors you can choose and edit if 
you like. Ahh; that is better!

I am not a great fan of reverting 
to OS 9 conventions just for the hell 
of it, but this is one worth trying 
out if you are a heavy Labels user. 
Not free, but a reasonable ($10). 
More info at <www.unsanity.com>.  
~ Steve Cooper
AUSOM News, Melbourne, Australia

Screen Saver News
You can get the news from 

an RSS feed on your screen as a 
Screen Saver. Command/click on 
your screen to Change Desktop 
Background. Shift to the Screen 
Saver tab. Select “RSS Visualizer.” 
Press “Options” and select the feed 
you wish to see. Now when your 
Screen Saver appears, you get the 
latest news on screen.

Mouse Droppings, Corvallis, OR

Creating Your Own  
Keyboard Shortcuts

One thing in OS X that doesn’t 
get enough press, but kicks butt in 
the productivity department, is that 
you can now create your own custom 
keyboard shortcuts. Here’s how:

Go under the Apple menu to 
System Preferences, then click on 
the Keyboard & Mouse icon. In 
the pane that appears, click on the 

“Keyboard Shortcuts” button. Then 
click the + (plus) sign button at 
the bottom of the list of existing 
shortcuts to add your own. The pop-
up menu at the top of the dialog 
that opens lets you choose whether 
this shortcut works across all 
applications, or in just an individual 
app (or just the Finder if you like). 
In the “Menu Title” field, enter the 
EXACT name of the menu item 
you want a shortcut for, then type 
in the shortcut you want to use and 
click “Add.” It is that easy.

Note: Make sure that the 
application you are creating your 
own shortcut for is not open.

TMUG Insider, Pleasanton, CA

Tiger

Jive (AppleTalk) Talkin’
Macintouch reader Mauro 

Notarianni ran into some AppleTalk 
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troubles with Tiger. He wrote “I 
just upgraded to Tiger. All was well 
until I tried to connect to my other 
Macs over the network and Tiger 
told me it was unable to connect. I 
got the following message: ‘This file 
server uses an incompatible version 
of the AFP protocol. You cannot 
connect to it.’ Great!”

The ubiquitous Tracy Valleau 
responded with the following fix:

“I too struggled with AFP 
issues until I figured it out. Your 
symptoms will go away if you do 
the following:
	 1. 	Fix permissions;
	 2. 	Shut down and wait 20 

seconds;
	 3. 	Start up into Open 

Firmware by pressing and 
holding the Command/
Option/O and F keys during 
startup;

	 4. 	At the Open Firmware 
prompt, type: ‘resetnvram’ 
(without the quotes) and press 
the Return key;

	 5. 	At the next Open Firmware 
prompt, type: ‘setdefaults’ and 
press Return (you’ll get an ‘OK’ 
response);

	 6. 	At the next Open Firmware 
prompt, type: ‘resetall’ and 
press Return. The computer 
will then restart and all will be 
well.”

Alan Oppenheimer, of Open 
Door Networks, Inc., sheds more 
light on the subject:

AppleTalk support has not been 
eliminated in Tiger. AppleTalk 
can still be used, for instance, for 
printing and service location. What 
has been eliminated is AppleShare 
or Apple Filing Protocol (AFP) 
support over AppleTalk. What 
this means is that Tiger machines 
can only connect to AppleShare-
compatible servers (in particular 

Personal File Sharing) that use AFP 
over TCP/IP.

Mac OS 9 has always supported 
AFP over TCP/IP through a version 
of our ShareWay IP product that 
Apple licensed and included in the 
system. You just have to check the 
box in the File Sharing Control 
Panel.

We sell an upgrade to the OS 9 
version that includes a number of 
added security features. We also 
sell a version of Share Way IP that 
runs all the way back to System 
7.5.5, so it’s still quite possible for 
anyone with very old systems (even 
68K ones!) to make their machines 
accessible to Tiger through Personal 
File Sharing.

We hope to be putting out a press 
release with more details shortly, but 
to highlight the suddenly-increased 
usefulness of ShareWay IP, we’ve 
halved the price of the product to 
$39 effective immediately. Details 
are available at http://www.
opendoor.com/shareway/.

MacValley Voice, Northridge, CA

Reindex Spotlight
Q: How can I make Spotlight 

start over with its indexing, or at 
least force it to re-index a particular 
volume, without reinstalling Tiger.  
~ Steve Osborn

A: If you can’t find what you’re 
looking for when you search with 
Spotlight, you may want to create 
a new index of your hard disk. But 
try a couple of things first: Use 
Disk Utility (/Applications/Utilities) 
to repair your file permissions, in 
case mucked-up permissions are 
the problem. (Launch the program, 
select the disk from the list, and 
click on “Repair Disk Permissions.”) 
Also, if you’ve recently indexed 
the drive, wait another day or so. 
Spotlight might not have finished 

indexing the drive even though 
you’ve been able to use it.

If your searches still don’t work, 
then try this: 

Open the Spotlight preference 
pane, click on the “Privacy” tab, 
click on the plus sign (+), and add 
the volume you want to re-index. 
Wait about five minutes, select the 
volume in the Privacy list, and click 
on the minus sign (-) to remove 
it. Spotlight will index the volume 
again from the ground up.

Mouse Tales, NorthCoast MUG, 
Berea, OH

You Can’t Find Widgets  
without a Map

Tiger brings desk accessories back 
to the Mac, only now they’re called 

“widgets.” One of them the Phone 
Book can show you maps by simply 
clicking on a search result, but 
www.MacOSXHints.com went one 
better with this tip: how to replace 
the phone book widget’s mapping 
service! They believe MapQuest is 
aging badly, and Google maps fit 
in better with the coolness of Tiger. 
To find out how to make the switch, 
click on http://www.macosxhints.
com/article.php?story=2005042
4065456133; you’ll find a couple 
of blocks of text there that you can 
easily copy and paste using a text 
editor to get the job done.

MacValley Voice, Northridge, CA

Apple Mail

Moving from Entourage to Mail
After being teased for being 

the only person at Small Dog to 
be using a mail application other 
than Mail, I decided to give Mail 
another try. This meant that I had 
to move from Entourage back to 
Mail (which I haven’t used since 

http://www.opendoor.com/shareway/
http://www.macosxhints.com/article.php?story=20050424065456133
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Office 2004 came out).
You might think that this 

would be a simple and transparent 
move, but to be honest, at first it 
was torture. This torture was due 
to two things: the sheer number 
of emails that I have saved since 
1998 and the fact that I had lots 
of learned behavior that needed 
retraining. It has now been just 
over a week and I’ve learned to 
like Mail, but I’ve had to find 
plug-ins and other solutions to 
do everything that Entourage did 
without the add-ons. There are still 
things that aren’t exactly the way 
that I would like them to be, but 
there are also a few things that I do 
like about the switch.

I started by importing all my 
mailboxes. This is where the torture 
for the change started. It took 
hours — MANY hours. This was 
largely due to the fact that I have 
saved mail since 1998. After about 
four hours, I realized that not all 
the mail was properly brought over 
from Entourage. Something just 
wasn’t right. So I tried again, which 
took about the same amount of 
time and again there were problems 
with the import. By now I was 
frustrated and wishing that I hadn’t 
started the project. I went home 
mad at myself for even trying to 
make the change.

During the evening, I had the 
idea that I didn’t need to save the 
huge amount of email that I was 
sitting on and came up with the 
great idea that since we use an 
IMAP server, I could store my 
messages on our mail server and be 
able to access mail from any mail 
application that I might decide to 
use in the future. So I came back 
to work invigorated to dump old 
mail and move everything to the 
new mail server. I made an archive 

of my mail database (to do this in 
Entourage, hold down the option 
key while launching Entourage) and 
then proceeded to delete mail older 
than 2003. Then I moved my mail 
to our mail server which was much 
faster than the import even though 
I had to do it manually.

So with less email and the 
ability to move between the two 
applications, I was able to spend 
time comparing one to the other 
and to get the feel of Mail since it 
has been sometime since I used it. 
The biggest difference between the 
two is how I used Entourage, which 
was to really put the Project Center 
to work. Everything that I would 
take on, I’d create a new project for, 
which would then tie in my email, 
contacts, files, tasks, calendar events, 
and notes. Everything was neat, 
organized, and connected.

Mail works differently. The 
standalone applications (Mail, 
Address Book, iCal,  TextEdit, 
and Stickies) do everything 
that Entourage does, but this 
fragmentation means that there 
is no easy or built-in way to 
connect everything. Here’s where 
a third-party add-on comes in: 
CRM4Mac by ibizzi (http://www.
crm4mac.com/). I tried several 
titles that claim that they do what 
CRM4Mac does, but CRM4Mac 
blew the others away with its speed 
and ease of use. You can download 
a full working demo to use for 30 
days, and the cost is about $50 if 
you decide that you like it. It’s one 
of the better Mac CRM titles that 
I’ve used.

Since I don’t necessarily want 
to pay for software that I already 
own (after all, I have Entourage), I 
still need to find some way to make 
my existing software more like 
Entourage while spending as little 

as possible. I came across two great 
plug-ins from a company called 
Indev. The first is MailTags and the 
second is Mail Act-On.

MailTags allow you to add 
metadata to any email message 

— things like keywords, projects, set 
priorities, due dates, and add notes. 
Once you tag a message, you can 
then create a Smart Mailbox based 
on the MailTag info, as MailTag is 
integrated with Spotlight. You can 
combine these metadata searches for 
a great deal of power. For example, 
you can create a Smart Mailbox 
that searches for all the messages 
for Project XYZZY that need a 
response in the next three days.

Mail Act-On adds power (as 
well as keyboard control) to Apple’s 
Rules. It allows you to map specific 
mail rules or actions to “Act-On” 
keys. When viewing mail, you 
can apply the “Act-On” action 
for a message by making simple 
keystrokes. I’m a big fan of David 
Allen’s book “Getting Things Done,” 
and use Mail Act-On to quickly 
move folders from my inbox to my 
action folders. Now when I receive 
a message, all I have to do is use 
my Act-On key. And since you can 
make rules with MailTags, you can 
use the two together.

Both titles are DonationWare 
(which supports future 
development) and can be found 
at the Indev web site (http://www.
indev.ca).

Now that I have Mail acting 
more like I want, I have to deal with 
scheduling, tasks, and notes.

I could easily use TextEdit or 
Stickies to create notes (as well as 
a number of other note-taking or 
word processing software titles) 
but I decided to try something 
new. I came across WikiNotes 
and VoodooPad, both of which 



Page � • February 2006 www.mac-hints-tips.com

are applications that allow linking 
between documents much like 
the way a Web Wiki works, except 
that it is on your desktop. Basically, 
you are creating your own “web 
world” of documents. WikiNotes 
is freeware, VoodooPad is 
shareware but there is a free version, 
VoodooPad Lite. Both are built on 
the idea of a Wiki. (For a description 
of Wiki within a Wiki: <http://
en.wikipedia.org/wiki/Wiki>.)

Just like a web site, my Wiki 
consist of a “home” page or index 
and then links from there to other 
documents, which can be linked 
to more docs, back to the original 
page, etc. As you might imagine, 
the full version of VoodooPad has 
more features than the others, but 
they both work great.

For VoodooPad: http://
flyingmeat.com/

For WikiNotes: http://members.
liwest.at/solar/

Last comes scheduling and tasks, 
for which I use iCal. The single 
biggest drawback for me is that 
I can’t schedule recurring tasks 
in iCal. The standard response 
is, “Make it an event and then you 
can make it repeat.” Well, that just 
doesn’t work for me. I have tasks 
that don’t relate to any specific day 
or time, and once I’m done, I need 
them to happen a week or month 
later. (For example, updating our 
radio ads.) I don’t have any specific 
day in which to get them updated, 
but once they are updated, I want 
to update them again about a 
month later.

The workaround that I found is 
web based and free, but requires 
setting up an account. The web 
site has the catchy name of 

“RememberTheMilk” (http://www.
rememberthemilk.com). It does a 
nice job of keeping tasks organized 

and you can share To Dos and 
access them from anywhere. You 
can set reminders to send an email, 
instant message, or text to your cell 
phone as a reminder. You can view 
the data from iCal by subscribing 
to the calendar that is created (it 
will add these tasks to your To 
Do list) or you can view the info 
by subscribing to its RSS feed. 
Lastly, you can email tasks using a 
provided email address, and they 
will be updated.

You may be wondering why I 
went through all this trouble, since I 
have Entourage and it was working 
well for me. Well, the reason is 
junk mail. Entourage’s Junk mail 
filter just didn’t work. The filter 
for Entourage is a little different 
from Mail in that it doesn’t learn. 
It is a set filter that is updated 
periodically by Microsoft. At first 
it worked great, but then I had 
some corruption which required 
rebuilding my database and it 
never worked again, even after I 
reinstalled the software and spent 
lots of time searching through 
forums and the Internet looking 
for solutions. I was hoping the next 
update would solve the problem, 
but it never improved. The other 
big reason was to appease the 
newsletter gods. Entourage adds 
all kinds of weird things to a mail 
message that require extra work to 
clean up. Often that wasn’t enough, 
and receivers would complain of 
oddities on their end.
Entourage vs. Mail

Entourage: Better sorting (or 
more sorting options, especially in 
the In Box) and interconnectivity 
through the Project Center are its 
best features for me. Junk mail and 
slow search speed are its weaknesses. 
Another thing I liked was being 
able to set the query for new mail 

messages differently for different 
mail accounts.

Mail: Its best attribute is its sheer 
speed, especially when looking for 
messages and Smart Mailboxes. 
This, along with better junk mail 
filtering, makes me glad that I 
moved back to Mail. I wish that it 
had many more features, but I was 
able to work around things. It is an 
important application for Apple, so 
I hope they keep adding features.

In the process of writing this 
article, I came across this web site, 
which has plug-ins and add-ons for 
Mail, iCal, Address Book, and a few 
others: http://www.timgaden.com/
hawkwings/.

~ Dawn@Smalldog.com
Small Dog Electronics

Internet

Hands-Free Shooting
Web site tells you how to set 

up a hands-free shooting rig for 
your digital photography! http://
www.macdevcenter.com/pub/a/
mac/2005/08/05/photography.
html/  ~ Victoria Maciulski

Fat Bits, Conejo Valley MUG 

Selective Searching
Q: I have a list of several 

Web sites I want to search for 
information or images. Do you 
know any way that I can limit a 
search to a list of Web sites?   
~ David Warkentin

A: Google lets you limit searches 
to a single Web site or a group of 
Web sites. The trick is to phrase 
your query correctly. You need to 
use a combination of “site:the site 
you want” and the OR variable.

http://members.liwest.at/solar/
http://www.timgaden.com/hawkwings/
http://www.macdevcenter.com/pub/a/mac/2005/08/05/photography.html/
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Travel to www.google.com (or 
type directly in Safari’s Google 
search field) and enter something 
like this in the Search field: 

“grunion site:stanford.edu” (without 
the quote marks). This limits your 
search for the noble fish to Stanford 
University’s domain. Or you 
can enter: “grunion site:stanford.
edu OR site:ucsd.edu OR site:
pepperdine.edu” (again without the 
quote marks). Now you and the 
grunion are really off and running. 
This query searches the sites of all 
three universities for information on 
your piscine pal.

Chris Breen’s Mac 911 
via Mouse Droppings, Corvallis, OR

David Pogue’s Google Tips
Phrase your question in the form 

of an answer, “After all, you’re not 
looking for Web pages that ask 
your question,” explains director 
of technology Craig Silverstein. 

“You’re looking for pages that answer 
it.” So instead of typing, “What is 
the average rainfall in the Amazon 
basin?”, you might get better results 
by typing “The average rainfall in 
the Amazon basin is.”

This is an old one, but very 
important: Put quotes around 
phrases that must be searched 
together. If you put quotes around 

“electric curtains,” Google won’t 
waste your time finding one set of 
Web pages containing the word 
“electric” and another set containing 
the word “curtains.”

Similarly, put a hyphen right 
before any word you want screened 
out. If you’re looking up dolphins, 
for example, you’ll have to wade 
through a million Miami Dolphins 
pages unless you search for 

“dolphins -Miami.”
Google is a global White Pages 

and Yellow Pages. Search for 

“phonebook:home depot norwalk, 
ct,” Google instantly produces 
the address and phone number of 
the Norwalk Home Depot. This 
works with names (“phonebook:
robert jones las vegas, NV”) as well 
as businesses. Don’t put any space 
after “phonebook.” And in all of the 
following examples, don’t type the 
quotes I’m showing you here.

Google is a package tracker. 
Type a FedEx or UPS package 
number (just the digits); when you 
click “Search,” Google offers a link 
to its tracking information.

Google is a calculator. Type in 
an equation (“32+2345*3234=”), 
Click “Search” to see the answer.

Google is a units-of-
measurement converter. Type 

“teaspoons in a gallon,” for example, 
or “centimeters in a foot.” Click 

“Search” to see the answer.
Google is a stock ticker. Type 

in AAPL or MSFT, for example, 
to see a link to the current Apple 
or Microsoft stock price, graphs, 
financial news, and so on.

Google is an atlas. Type in 
an area code, like 212, to see a 
MapQuest map of the area.

Google is Wal-Mart’s computer. 
Type in a UPC bar code number, 
such as “036000250015,” to see 
the description of the product 
you’ve just “scanned in.” (Thanks 
to the Google Blog, http://google.
blogspace.com, for this tip.)

Google is an aviation buff. 
Type in a flight number like 

“United 22” for a link to a map of 
that flight’s progress in the air. Or 
type in the tail number you see on 
an airplane for the full registration 
form for that plane.

Google is the Department of 
Motor Vehicles. Type in a VIN 
(vehicle identification number, 
which is etched onto a plate, usually 

on the door frame, of every car), like 
“JH4NA1 157MT001832,” to find 
out the car’s year, make, and model.

For hours of rainy-day 
entertainment, visit http://labs.
google.com. Here, you’ll find 
links to new, half-finished Google 
experiments-like Google Voice, in 
which you call (650) 623-6706, 
speak the words you want to search 
for, and then open your browser 
to view the results. Disclaimer: 
It wasn’t working when I tried it. 
(Ditto a lot of these experiments.)

Poke around the “Services & 
Tools” link on the Google.com home 
page, and you’ll find some of the 
better-known lesser-known Google 
features, if that makes any sense.

New York Times.com  
via Connecticut Macintosh Chronicle

MS Word

Indispensable Tips  
for Word Users

No matter how long you’ve been 
using Microsoft Word, you can 
always learn new techniques to help 
you work faster and smarter. 

Here are some favorite tips and 
tricks:

Learn to use Undo: Make a 
mistake? Press Command/Z or 
choose “Undo” from the Edit 
menu right away. Keep pressing 
Command/Z to backtrack through 
and undo the most recent editing 
changes you’ve made.

Save often: Press Command/S 
or click the “Save” button on the 
Standard toolbar. Save your work 
frequently. You can also instruct 
Word to automatically save your 
work periodically. Open the Tools 
menu, select “Options,” click the 

“Save” tab, and activate the “Save 
AutoRecovery Info Every” option. 

http://google.blogspace.com
http://labs.google.com
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You can specify an interval from 1 
to 120 minutes.

Quickly move around in a 
document: To move to the top 
of a document, press Command/
Home. To move to the bottom of 
a document, press Command/End. 
To go to the top of the next page, 
press Command/Page Down. For 
the top of the preceding page, press 
Command/Page Up.

Select a word: Double-click on 
it. If a space immediately follows 
the word you select, the space gets 
selected, too. Punctuation is ignored.

Select a sentence: Hold down 
the Command key and click 
anywhere in the sentence.

Select a paragraph: Triple-click 
within the paragraph or move the 
mouse just past the left margin of 
the paragraph. When the pointer 
changes to a right-pointing arrow, 
double-click to select the entire 
paragraph.

Select all the text between the 
insertion point and …: To select 
all the text between the insertion 
point and the end of the current 
line, press Shift/End. To select 
the text from the insertion point 
through the end of the current 
paragraph, press Command/Shift 
and the down arrow. To select the 
text from the insertion point to 
the end of the document, press 
Command/Shift/End.

Rename an existing document: 
Use “Save As.” When you need to 
use an existing document as the 
basis for a new one, don’t overwrite 
the old document. As soon as you 
open it, open the File menu and 
choose “Save As.” Then immediately 
type a new name or change some 
part of the old one.

Grow font, shrink font: Here 
are three quick ways to change 
the size of selected text: Choose 

“Font” from the Format menu and 
specify the desired point size: Click 
the “Font Size” button on the 
Formatting toolbar and select an 
entry from the drop-down list. Or 
use the “Grow Font” and “Shrink 
Font” shortcuts, which are the 
Command key plus the close- and 
open-square bracket characters ([ ]), 
respectively.

Print envelopes: Want to 
address your envelopes in the 
printer? Type an address in a blank 
document or in a letter. Open the 
Tools menu and select “Envelopes.” 
In the Envelopes tab, enter the 
return address if you want one, and 
click “Print.”

Expand your vocabulary: Word 
has a built-in thesaurus. Press 
Shift/F7 or open the Tools menu, 
select “Language,” and then choose 

“Thesaurus.” Word will display a list 
of synonyms for the word you’ve 
selected or the word closest to the 
insertion point marker.

Make friends with the right 
mouse button: Don’t be afraid to 
right-click on a block of text or a 
table cell. The shortcut menu offers 
immediate access to some handy 
formatting options.

Paste plain text: When you copy 
and paste text from a Web page or 
another document, the text brings 
its formatting into your document. 
To get around that behavior, copy 
the text and place the insertion 
point marker where you want to 
insert the copy. Then, open the 
Edit menu, choose “Paste Special,” 
and select the “Unformatted Text” 
option.

Effortless AutoText: Save 
time by inserting AutoText 
automatically. Type an entry name 
and press “F3.” Or take advantage 
of Word’s AutoComplete feature. 
Just open the Tools menu, select 

“AutoCorrect,” click the “AutoText” 
tab, and turn on the “Show 
AutoComplete Tip for AutoText and 
Dates” option. With this feature 
active, Word will show a ScreenTip 
after you begin typing an AutoText 
item. Just press “Enter” and Word 
will insert the item for you. (This 
feature works the same way with 
dates and days of the week.)

Instant AutoCorrect: Right-
click on a word that’s flagged as 
misspelled to display the Edit 
shortcut menu. If Word has a 
suggested alternative, AutoCorrect 
will appear on the menu. Choose 

“AutoCorrect” and then select 
the correct version of the word 
from the submenu to create an 
AutoCorrect entry.

Marker display: Work with 
paragraph markers and tab marks 
displayed. Simply click the Show/
Hide Invisibles (¶) button on the 
Standard toolbar. Displaying those 
normally hidden characters helps 
you avoid inadvertently deleting 
objects or changing formatting; 
it also helps you figure out funky 
alignment and extra white space 
problems.

Clear a table: If you need to 
delete the contents of all the cells 
in a table, just select the table and 
press “Delete” (not “Backspace”).

Jump quickly between 
documents: If you work with a lot 
of open, overlapping documents, 
here’s a quick way to cycle between 
them: Press “Control/F6” to jump 
from one to the next; Control/Shift/
F6 will jump you backward.

TMUG Insider, Pleasanton, CA

Norton Anti-Virus

Norton AV, Rest in Peace
Norton Antivirus for the Mac 
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lives! Kind of. I still think it’s on life 
support, but the company reversed 
itself and released a new version 10 
that may be compatible with Tiger; 
the jury is still out.

As to a compelling reason to pay 
money for this upgrade, http://
www.symantec.com/nav/nav_mac/ 
says “Don’t jeopardize your valuable 
data or risk passing infections to 
colleagues with PCs.”

There we have it in a nutshell. 
There still isn’t any credible virus 
threat on the Mac, but as “good 
citizens” we should pay Symantec 
so we don’t inadvertently infect 
PC users? Puhleeze! As far as I’m 
concerned, if a PC user isn’t using 
anti-virus software and keeping 
it up-to-date, he or she gets what 
he or she deserves. Installing, 
maintaining, and fiddling with anti-
virus software is the price you pay 
for using Windows. Why take away 
their fun?

Another thing to consider is 
if a real virus or virus-like threat 
appears on the Mac platform 
someday, it will almost certainly be 
UNIX-based which is something 
a product like Norton AV will be 
powerless to defend against. Add to 
that version 10’s almost glacial speed 
when scanning drives and penchant 
for interfering with the proper 
functioning of Adobe software and 
you’ve got one more reason to close 
your wallet and go home.

MacValley Voice, Northridge, CA 

Photoshop

Tip for Magnetic Tools
When using the Magnetic Lasso 

or Magnetic Pen tool in Photoshop, 
press the Caps Lock key to see the 
exact area where the tool is looking 
for an edge. To change the size of 

the area it’s using for its calculations, 
type right or left brackets ( ] or [ ). 
~ Ben Willmore

Design Tools Monthly

Photoshop CS2’s Red Eye Tool
Photoshop CS2 has a Red Eye 

removal tool hidden under the 
Healing Brush tool. To access 
it, click and hold on the Healing 
Brush tool. One of the brush 
alternates that appears is the Red 
Eye tool. 

To use it, click on the red portion 
of the eye in your photo and adjust 
the pupil size and darkness in 
the Options Bar at the top of the 
Photoshop workspace.

Design Tools Monthly

Targeting vs. Selecting Layers
Targeting and selecting layers in 

Photoshop CS2 is a very important 
distinction now that you can 
Command/click or Shift/click to 
target multiple layers. 

Because of this, you need to pay 
attention to where you click on 
the layer. Command/clicking on 
the layer thumbnail will create a 
selection around all nontransparent 
areas on the layer. Command/click 
on the layer’s name to actually 
target the layer itself.

Layers Magazine

Working with Guides  
in Photoshop

Hold Option to change the 
direction of the guide (horizontal/
vertical), hold Shift to snap it to the 
tick marks of your ruler, and hold 
Command to move guide when 
using tool other than the Move 
tool. Hold the Control key after 
you start to drag something (guide, 
selection, layer, etc.) to prevent it 
from snapping to other objects.

LIMac Forum, Long Island, NY

Save JPEGs as PSDs to Preserve 
Quality

If you start with a JPEG image, 
perhaps from a digital camera, 
and alter it, don’t save it again as 
a JPEG; you’ll lose image quality 
every time you re-save an image 
in JPEG format. Instead, save the 
altered image as a PSD file and 
make a JPEG copy if you need 
to post the image to the Web, for 
example. In the meantime, you’ll 
have a good copy of your altered 
image in PSD format for use in 
other applications, such as for 
printing photos or using them in a 
printed brochure.

Element K Journals  
via LIMac Forum, Long Island, NY

Adding New Text  
Close to Existing Type

Did you ever try to add some 
new text a little too close to some 
existing text, only to have the Type 
tool assume you want to edit the 
existing text? To avoid this, hold 
down the Shift key as you click with 
the Type tool — this will ignore the 
existing text and create a new Type 
layer, no matter how close you click 
to the original text.

Layers Magazine

Reset Misbehaving  
Photoshop Tools

Sometimes in Photoshop, a tool 
behaves strangely and you can’t 
figure out why. The easy way out is 
to reset its options to their defaults 
by Control/clicking the tool’s icon 
in the far left of the Options Bar. A 
contextual menu will appear, from 
which you choose “Reset Tool.”  
~ Peter Baiter

Mac Design Magazine  
via Design Tools Monthly
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and hardware announcements, upcoming seminars and shows, interesting websites, and other valuable information. You may request a free 
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by Scott Kelby, the President of the National Association of Photoshop Professionals, and also editor of Photoshop User, the NAPP’s excellent 
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•	 MacAddict Magazine. “A better machine. A better magazine.” Every issue of MacAddict is packed with in-depth how-to articles, fact-filled 
features, and expert reviews, plus a monthly CD of hot product demos, tutorials, freeware, and video how-to stories and interviews.  
www.macaddict.com

•	 The macHome Journal, the ultimate magazine for the Macintosh consumer, offering practical advice for everyone. macHome Journal offers 
excellent how-to articles and advice on purchases, and Hot Tips on line. www.machome.com.
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www.macworld.com.

•	 The New York Times, New York City, New York.

If you are not a member of a Macintosh User Group, I highly recommend that you find one in your area and join. User groups are the greatest 
source of information and help available to all Mac users — from novices to experts. Find one in your area at apple.com/usergroups/find. 


